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Op32Rx – программа приема сигналов OPERA на любительском диапазоне 136 кГц (2200 м).
Установить и настроить эту программу очень легко. 

1. Скачайте  с  сайта  http://rn3aus.136.su/Op32Rx/index.html (резервный  сайт
http://rn3aus.narod.ru/Op32Rx/index.html )  архив  последней  версии  программы.  На
момент  написания  этого  руководства  это  v.1.8.6:
http://rn3aus.136.su/Op32Rx/Op32Rx_v.1.8.6_release.zip

 
2. Распакуйте  архив  в  произвольный  каталог  на  жестком  диске  Вашего  компьютера.

Никакой инсталляции не требуется.

3. Запустите файл Op32Rx.exe. При первом запуске появится предупреждение: 

Нажмите OK, необходимые данные мы введем позже.

4. Появится рабочее окно программы Op32Rx и рядом с ним окно Opera Chat.

5. Войдите в меню Settings → Setup another settings (CALL, QTH, thresholds)...  Откроется
окно настроек.

http://rn3aus.136.su/Op32Rx/Op32Rx_v.1.8.6_release.zip
http://rn3aus.narod.ru/Op32Rx/index.html
http://rn3aus.136.su/Op32Rx/index.html


Заполните поля My CALL, My QTH-loc, My City, My Name, My Ant.

Внимание! Если позывной сигнал имеет в своем составе дробь, например  AA1AA/1,
рекомендуется  вводить  его  как  AA1AA-1.  В  противном  случае  Вы  не  сможете
подключиться к кластеру EA4RCH-5, через который осуществляется обмен спотами.

6. Проверьте  настройки Вашего радио.  Стандартная  частота  настройки обычно  равна
136000 Гц, при этом центр полосы частот, выделенной для работы в режиме  OPERA
137500 Гц будет соответствовать аудиочастоте 1500 Гц. Эти настройки установлены по
умолчанию. Однако программа Op32Rx позволяет работать и с нестандартными Dial.
Например, Ваш приемник имеет  Dial  134400  Гц.  В таком случае центр окна  OPERA
придется  на  аудиочастоту  137500  —  134400  =  3100  Гц.  Вводим:
Fdial  [Hz]=134400,  Fcenter  [Hz]=3100.   Центральная  аудиочастота  может  быть  в
пределах от 400 Гц до 23000 Гц, что позволяет использовать любые типы самодельных
приемников и конвертеров. 

На этом первоначальные настройки можно завершить и нажать кнопку Apply. Однако для
более полного знакомства с программой рассмотрим остальные настройки. Возможно,
Вам никогда не понадобится их изменять.



7. Поле  Capture  path  определяет  путь  к  папке,  где  будут  сохраняться  скриншоты
декодированных сигналов. Пример такого скриншота:

Подобный скриншот дает наглядное представление о ходе приема сигнала, по нему
легко определить было ли декодирование верным или ложным. Каждый скриншот
имеет уникальное имя, например G3XDV_20161018_2251.jpg — позывной сигнал, дата
и время декодирования. Таким образом в папке Capture Вы будете иметь коллекцию
скриншотов всех принятых Вами корреспондентов.

8. Уникальное имя файла не очень удобно, если скриншот желательно выкладывать в
интернет.  Однако  программа  создает  также  каждый  раз  скриншот  с  именем
op32rx_capture.jpg (это имя можно задать в поле Capture file). Файл будет помещен в
рабочую папку программы Op32Rx.exe

9. Поле  Exec  command  if  decoded  позволяет  при  каждом  декодировании  выполнять
какой-либо скрипт, например, для отправки спота в интернет и т. п.  Проверить запуск
скрипта можно кнопкой  Test.  Чекбокс разрешает выполнение команды. В качестве
параметров  командной  строки  запускаемому  файлу  передаются  несколько
параметров, разделенных пробелами:
DATE TIME CALL FREQ QRB SNR FADE
Например:
2020-01-04 20:01:23 RN3AUS 137500.00 61 -15.8 12
Здесь QRB [км] — расстояние, если оно не известно, то -1
SNR [dB] – отношение сигнал-шум
FADE  — процент  замираний  сигнала.  Если  сигнал  принят  не  декодером,  а
корреляционным детектором, то значение FADE=200.

 10.Наиболее тонкие настройки — величины порогов. От их величин зависит правильная
работа  программы.  Если  пороги  уменьшать,  то,  с  одной  стороны,  возрастет
чувствительность  к  слабым  сигналам,  но  одновременно  увеличится  и  вероятность
возникновения  ложных  декодирований.  По  умолчанию  пороги  установлены
близкими к оптимальным значениям. С такими настройками мой граббер работает
несколько лет. 

 11.Порог декодера нужно выбрать таким, чтобы он был несколько выше, чем у  изредка
возникающих  ложных  декодирований,  отображаемых  в  строке  состояния  главного
окна, например: «DEC: 5O0UAV 1.3dB 41 137505.3». В данном случае уровень ложного



декодирования  составляет  1,3 dB.  По  результатам  многих  экспериментов  порог
декодера должен иметь величину  от 2 до 3 дБ.

 12.Порог корреляционного детектора «opds» может быть несколько ниже, от 1.5 до 2.5
дБ. Установив желаемый порог, нужно проверить качество работы в течение суток и
убедиться, что ложные детектирования отсутствуют. 

 13.Порог  OPDS  Max1/Max2  имеет  следующий  смысл.  При  сравнении  с  принятым
сигналом нескольких вариантов сигналов, соответствующих тем или иным позывным
из списка callsloc.txt,  выбираются два, дающих наибольшие корреляционные суммы.
Величины  этих  корреляционных  максимумов  (Max1  и  Max2)  сравниваются  между
собой.  Дальнейшая  обработка  будет  происходить,  если  отношение  Max1/Max2
превысит порог. Эксперимент дает основание устанавливать этот порог порядка 2.5
дБ.

 14.В программе реализован довольно интересный вариант корреляционного детектора
— бинарный (жесткий) коррелятор. Его достоинство — независимость  характеристик
от вида шумов. Порог задает минимально необходимое количество совпавших битов.
Например, порог равный 164 (из 239) обеспечивает крайне редкое возникновение
ложных обнаружений. Несколько большую чувствительность обеспечивают пороги от
161 до 163. Оценка вероятности ложного обнаружения сигнала приводится правее
поля  ввода  порога.  Например,  для  порога  164  ложное  обнаружение (в  отсутствие
мощных помех, по белому шуму) будет происходить не чаще одного раза в 5 месяцев.

 15.Параметр  Opera dB offset  служит для того,  чтобы оценки  SNR  принятых сигналов с
помощью  Op32Rx  и  Opera1.6.5  в  равных  условиях  были  одинаковыми.  В  Op32Rx
измерение  SNR  происходит в полосе 100 Гц. В другой программе, вероятно, полоса
составляет 1 кГц. Экспериментально была определена поправка, равная -10дБ.

 16.Параметр  CALL  blocking  time  задает  время  блокировки  повторных  обнаружений
одного и того же позывного сигнала. Так как один цикл передачи Opera-32 занимает
32 минуты, то, очевидно, повторное обнаружение не может состояться раньше, чем
эта передача завершится. Тем не менее имеет смысл задать этот параметр от 10 до 20
минут  на  случай,  если  по  какой-то  причине  корреспондент  был  вынужден
приостановить незавершившуюся передачу и начать ее заново.

 17.Итак,  мы  рассмотрели  все  настройки.  Теперь  нажимаем  кнопку  Apply,  чтобы
сохранить их. Кроме того, будет вновь загружен в память файл callsloc.txt. Это бывает
полезно,  когда  callsloc.txt  был  скорректирован,  но  перезагружать  программу,
прерывая  прием,  нежелательно.  Достаточно  просто  зайти  в  дополнительные
настройки и ничего не меняя нажать Apply. 

 18.Запустив  Op32Rx.exe,  нужно задать ряд настроек,  находящихся в меню  Settings.  По
умолчанию включены настройки, подходящие для большинства случаев. Возможно,
Вам  даже  не  потребуется  ничего  менять.  Но  знать,  что  эти  настройки  означают,
несомненно, было бы полезно. Рассмотрим их по порядку.



 a) Select sound input – если в Вашей системе имеется несколько звуковых устройств,
Вы можете выбрать любое из них из списка.

 b) Capture  spectrum –  сохранять  скриншот принятого  сигнала (более  подробно об
этом мы уже говорили — смотри пункт 7)

 c) Ignore Loran  lines  –  в  рабочей директории программы есть  файл  loran_lines.txt,
содержащий перечень частот,  которые будут игнорироваться.  Вы также можете
вносить сюда любые частоты, на которых у Вас постоянно присутствует помеха. Это
можно делать либо непосредственно корректируя этот файл, либо наведя курсор
на спектрограмме и, нажав правую кнопку мыши, выбрать  Add this frequency to
Ignore list.

 d) Use freq list – в рабочей директории есть файл freq_list.txt, содержащий перечень
частот,  которые  всегда  будут  обрабатываться,  даже  в  случае  отсутствия
спектрального  максимума.  Этот  список  пополняется  автоматически  во  время
каждого нового декодирования — в него заносится частота, на которой работал
корреспондент.  Многие  из  нас  имеют  свои  «любимые»  частоты,  поэтому
программа  будет  следить  за  этими  частотами  более  пристально.  В  частности,
декодер  будет  выполнять  на  этих  частотах  больше  итераций  в  надежде
обнаружить слабый сигнал.

 e) Use decode filtering with callsloc.txt – это самая рекомендуемая опция. Пожалуйста,
используйте  эту  опцию  для  исключения  ложных  декодов!  Смысл  фильтрации
следующий:  позывной  сигнал,  обнаруженный  декодером,  сравнивается  со
списком  известных  позывных  (callsloc.txt).  Если  позывной  в  списке  есть,



происходит  его  дальнейшая  обработка.  Если  же  это  новый  или  странный
позывной,  то с  высокой долей вероятности это  просто ложное декодирование.
Однако этот позывной не отбрасывается, а запоминается. Если будет повторное
его декодирование на той же частоте,  то программа предполагает,  что в эфире
работает  новый  корреспондент,  которого  еще  не  успели  включить  в  файл
callsloc.txt.  Его  позывной  записывается  в  файл  known_list.txt и  дальнейшая
обработка разрешается. Итак, новый корреспондент должен два раза выполнить
передачу на одной частоте. Первый раз он будет проигнорирован, во второй раз
он успешно декодируется и будет занесен в список. Теперь каждая передача будет
приносить успешный декод. 

Примечание: иногда возможно ложное декодирование на фоне мощного сигнала другого
корреспондента, может несколько раз на одной и той же частоте декодироваться странный
ложный  позывной  сигнал.  Он  будет  занесен  в  файл  known_list.txt,  что  приведет  к
повторяющимся  ложным  рапортам.  Поэтому  хорошим  правилом  было  бы  периодически
проверять содержимое файла known_list.txt и удалять из него заведомо ложные позывные, а
найденные  правильные  переносить  в  callsloc.txt,  дополнив  их  соответствующими  QTH-
локаторами.

 f) Для очистки (удаления) файла known_list.txt служит пункт меню Cleanup know_list.
Используйте эту команду периодически (раз в неделю или в месяц).

 g) Iterative Decoder – разрешает декодеру выполнять итерационное декодирование.
Наименее  надежные  биты  принятого  сигнала  будут  последовательно
инвертироваться в различных комбинациях, пока не совпадет контрольная сумма
CRC  сообщения  либо  не  будет  исчерпано  разрешенное  количество  итераций.
Рекомендуется использовать эту опцию.

 h) Use  binary  PIC  correlator  (+  Use  soft  correlator  OPDS)  –  эти  опции  включают
корреляционный поиск позывных сигналов, перечисленных в файле callsloc.txt. 

 i) Frequency drift tracking –  включает режим отслеживания медленного частотного
дрейфа (при недостаточной стабильности опорного генератора передатчика или
нашего приемника). Однако при этом несколько возрастает загрузка процессора и,
возможно, немного уменьшается помехоустойчивость.  Используйте эту опцию в
случае необходимости.

 j) Sample rate offset compensation –  частота дискретизации звуковой карты может
отличаться от номинала и быть вместо 12000 отсчетов в секунду, например 12010.
Это приводит к постепенно увеличивающемуся временному сдвигу, что ухудшает
помехоустойчивость  приема.  Используйте  эту  опцию  при  явных  проблемах  с
неточностью Sample rate. Загрузка процессора несколько возрастает.

 k) Peak  number  –  для  уменьшения  вычислительных  затрат  для  дальнейшей
обработки выбираются несколько спектральных максимумов, так как даже самый
слабый сигнал дает достаточно заметный спектральный пик, хорошо заметный на
спектре с большим усреднением. Обрабатывать весь спектр нет никакого смысла.
Можно  ограничить  количество  таких  спектральных  пиков.  Минимально
необходимо 10 пиков. Для любой ситуации вполне достаточно будет обрабатывать
20  или  30  пиков.  Чем  больше  пиков  обрабатывается,  тем  больше  загрузка
процессора.

 l) Peak  spacing  –  редко  когда  сигналы  передаются  очень  близко  друг  к  другу  по
частоте. Поэтому можно указать минимальное расстояние между спектральными
пиками. Обычно вполне достаточно установить его равным 0.2 — 0,4 Гц.

 m) Peak threshold – чтобы спектральный максимум был взят на обработку, он должен
превысить некоторый небольшой порог по отношению к усредненному уровню



шума. По умолчанию эта величина равна 0,4 дБ.
 n) Upload  spots  –  разрешить  отправку  спотов  декодера  на  сайт

https://pskreporter.info/pskmap.html. 
 o) Upload  correlator/opds  spots  –  разрешить  отправку  спотов  корреляционного

детектора (на сайт pskreporter и в базу данных)
 p) Upload  spots  to  Opera  Database  –  разрешить  запись  спотов  в  базу  данных

http://spots.microwavers.es/index.php и  отправку  сообщений  в  Opera  Chat  на
кластере  EA4RCH-5.

Рекомендуется все эти галочки включить, чтобы результаты Вашего приема были доступны
всем радиолюбителям.

19. Настроить внешний вид программы можно в меню  View. 

Главное окно программы состоит из пяти зон: 
• Осциллограмма  —  здесь  отображается  принимаемый  с  эфира  сигнал.  Он

автоматически  нормируется  по  амплитуде.  Если  присутствуют  импульсные
помехи,  то они подавляются Noise Blanker.  Если импульсов слишком много,
осциллограмма становится красной.  Если в спектрограмме курсором выбрать
какую-либо частоту (клик  левой  кнопкой мыши),  то  вместо  осциллограммы
можно наблюдать вид сигнала после фильтра и детектора на этой частоте, либо
видеть  развертку  спектрограммы  в  режиме  QRSS-вьюера.  Осциллограмму
можно отключить.

http://spots.microwavers.es/index.php
https://pskreporter.info/pskmap.html


• Spectrum – синей линией отображается мгновенный спектр, красной — спектр
с большим усреднением. На красном спектре хорошо заметны спектральные
максимумы. Над этими максимумами располагаются зеленые штрихи — это
означает,  что  данный  максимум  обрабатывается  декодером.  Если  же  над
максимумом  присутствует  черная  полоска  —  данная  частота  временно
заблокирована и не обрабатывается. Спектр можно отключить.

• Спектрограмма  (водопад).  Здесь  можно  наблюдать  трассы  сигналов  и
тональных помех.  Отключить  водопад нельзя.  Время развертки водопада  на
всю высоту примерно соответствует длительности одной передачи Opera-32.
Если  сигнал  декодирован,  на  водопаде  появляется  отметка  с  позывным  на
соответствующей  частоте.  Если  трасса  сигнала  видна,  то  декодирование  с
высокой  степенью  вероятности  правильное.  Контрастность  водопада  можно
настроить в меню View->Waterfall contrast. Доступны три градации контраста.
Наиболее приятно выглядит водопад с контрастом Low.

• Текстовая зона спотов. Каждая строка состоит из следующих полей:
◦ DATE – дата
◦ TIME – время
◦ CALL – позывной сигнал
◦ FREQ – частота
◦ QRB  –  расстояние  до  корреспондента  (QTH-локатор  берется  из  файла

callsloc.txt)
◦ Eb/No – оценка отношения сигнал-шум да выходе детектора. Эта оценка не

является в строгом смысле величиной Eb/No и названа так условно.  Эта
величина сравнивается с порогами декодера и корреляционного детектора.

◦ SNR – отношение  сигнал-шум на входе  приемника в  полосе  1  кГц.  Эта
величина передается в спотах в базу данных, Opera-кластер и pskreporter.

◦ DEC – количество итераций декодера. Если же сработал корреляционный
детектор  —  то  символ  'c'  для  битового  коррелятора  и  'd'  —  для  opds.
Наиболее достоверным результатом приема является чистое декодирование,
без привлечения корреляторов. 

◦ FADE – процент замираний сигнала.
• Строка состояния. Здесь есть несколько полей, где отображается информация

об  уровне  сигнала  на  входе  звуковой  карты  (желательно,  чтобы  он  был  в
пределах  -20...-40  дБ),   сообщения  декодера/коррелятора,  количество
обрабатываемых  спектральных  пиков,  наличии  подключения  к  серверу
pskreporter для отправки спотов.

Нужно заметить, что в зависимости от модели компьютера и версии операционной системы
отключение отображения осциллограммы и спектра может в ряде случаев снизить загрузку
CPU почти в два раза.

20.  Меню File содержит полезный пункт Decode WAV-file. Если имеется запись эфира в
формате 16 бит, 12ksps или 48ksps, то эту запись можно обработать, применяя те или
иные настройки порогов декодера и т. п. Во время обработки записи отправка спотов
автоматически блокируется.  По окончании обработки записи  работа  программы со
звуковой картой возобновляется. 

21. Все настройки программы можно предварительно сохранить File->Save settings to INI-
file.  При  штатном  закрытии  окна  программы  все  настройки  также  сохраняются,
однако если компьютер выключился внезапно, настройки могут быть утрачены.



FAQ
Вопрос: мой  компьютер  довольно  старый  и  загрузка  процессора  программой  Op32Rx
достигает 50%. Как я могу уменьшить загрузку CPU?
Ответ: Задайте минимальные настройки — Peak number = 10, Use freq list=OFF, Use binary PIC
correlator  (+  Use  soft  correlator  OPDS)=OFF,  Frequency  drift  tracking=Sample  rate  offset
compensation=OFF.  В  меню  View  отключите  Oscillogramm  и,  возможно,  Spectrum.  Все  эти
меры снизят загрузку CPU в два-три раза. В самом крайнем случае отключите опцию Iterative
Decoder.

Вопрос:  отсутствует  подключение  к  кластеру,  я  не  вижу  спотов,  в  строке  состояния  окна
Opera Chat написано Disconnect или Socket Error?
Ответ: 

• проверьте,  что  обмен  с  кластером  включен:  установлены  галочки  Connect
(подключиться к кластеру) и Upload (отправлять споты на кластер и в базу данных).

Если все в порядке, в строке состояния окна Opera Chat будет наблюдаться активность
кластера.

• проверьте, что Ваш позывной сигнал введен в окне  Settings-> Setup another settings.
Убедитесь,  что позывной сигнал не зодержит символов «/».  Их лучше заменить на
дефис.  Таковы  требования  кластера.  В  качестве  логина  не  удается  использовать
позывные с дробями.

• Проверьте подключение к кластеру по  telnet.  Для этого в win10 telnet  необходимо
включить:  “Панель  управления\Все  элементы  панели  управления\Программы  и
компоненты\Включение  или  отключение  компонентов  Windows”.  Появится  окно
настроек, где нужно найти Telnet client и отметить галочкой.



Затем  можно  в  командной  строке  cmd  набрать:  telnet  144.76.158.174  8000
На черном экране должно появиться “login:”

• Проверьте  параметры  брандмауера  Wundows:  «Панель  управления\Все
элементы  панели  управления\Брандмауэр  Защитника  Windows\Разрешенные
программы»



Вопрос: экспериментируя с настройками я, кажется, все испортил и не могу вспомнить, какие
настройки были вначале. Как вернуться к настройкам по умолчанию?
Ответ:  просто  удалите  файл  Op32Rx.ini.  При  новом  запуске  программы  этот  файл  будет
создан  заново  с  настройками  по  умолчанию.  Вам  придется  вновь  ввести  свой  позывно
сигнал, локатор и т. д.

Вопрос: от меня идет слишком много ложных декодирований. Именно декодирований, не
deepsearch.
Ответ: 

• включите рекомендованную опцию Settings->Use decode filtering with callsloc.txt
• убедитесь,  что  при  загрузке  в  строке  состояния  отсутствует  предупреждение:

«Warning!  Callsloc.txt  is  empty».  Скачайте  новый  файл
http://rn3aus.136.su/Op32Rx/callsloc.txt.

• Проверьте  и  очистите  файл  known_list.txt.  Здесь  содержатся  ранее  неизвестные
позывные,  дважды  обнаруженные  на  одной  частоте.  Возможно,  это  произошло  в
результате  приема на фоне мощного  сигнала.  Просто удалите  странные  позывные
сигналы.

• Может быть  настало  время  немного  изменить  порог  декодера.  Увеличьте  его  для
начала на 1 дБ. 

Вопрос: включил опцию Use binary PIC-correlator и появились ложные споты deepsearch, при
этом позывные сигналы настоящие, но не работавшие в данное время.
Ответ: Вам нужно повысить порог Correlator239 threshold (окно дополнительных настроек).
Увеличьте его на единицу. Достаточно мало ложных срабатываний происходит при пороге
равном 164. И не забудьте опять же проверить файл known_list.txt.

Вопрос: то же самое при включении Soft correlator (opds).
Ответ:  Нужно увеличить порог opds threshold на,  скажем, 1 дБ. Немного увеличьте порог
Opds Max1/Max2 threshold, на 0.2 дБ.

Вопрос: я уже пробовал повышать пороги и т. п. В общем все работает нормально. Но когда в
эфире начинает работать мой сосед с мощным сигналом, я все равно иногда вижу ложные
споты. В чем тут может быть дело? Почему это вообще происходит?
Ответ: Причина заключается в том, что Opera использует довольно слабое помехоустойчивое
кодирование с небольшим "кодовым расстоянием". Информация защищена CRC-16. Декодер
Op32Rx выполняет множество итераций путем инвертирования наименее правдоподобных
битов, мягкие оценки которых были получены из демодулятора. Это выполняется до тех пор,
пока  CRC  не  совпадет  или  не  закончится  допустимое  число  итераций.  Оказывается,
совпадение CRC может происходить гораздо чаще, чем кажется! В результате, комбинация
битов  может  быть  выбрана  из  шума  так,  что  CRC  является  правильным  и  ложное
декодирование  происходит  с  периодом  примерно  один  раз  в  несколько  часов.  Однако
измеренное Eb/No в этом случае обычно не превышает 1-2 дБ. При приеме не только белого
шума, но и любых  мощных  посторонних сигналов уровень ложного декодирования  Eb/No
может  быть  больше 6-8  дБ!  Поэтому  в  некоторых случаях  недостаточно увеличить  порог
декодирования "Settings" - > Setup  - > Decode threshold (Порог декодирования). Поэтому мне
пришлось выполнять дополнительную фильтрацию декодирования, сравнивая их со списком
известных позывных сигналов (Settings - > Use decode filtering). 
Похожая ситуация имеет место и с корреляционным детектором. К сожалению, формат PIC
кодов  Opera  имеет  довольно  высокий  уровень  кросскорреляции  между  различными

http://rn3aus.136.su/Op32Rx/callsloc.txt


позывными  сигналами.  Если  взять  PIC  код  одного  из  корреспондентов  и  подсчитать
количество  его  совпадений  со  сдвинутой  на  несколько  позиций  PIC  кодом  другого
корреспондента, то были найдены случаи, когда совпадало до 184 позиций из 239, то есть
почти  77  процентов!  Это  очень  сильная  кросскорреляция.  Вполне  естественно,  что
корреляционный  детектор  будет  срабатывать  с  некоторым  сдвигом  (задержкой  или
опережением относительно правильного момента времени) при приеме мощного чужого
сигнала.
В программе Op32Rx.exe применено множество механизмов для защиты от этих негативных
явлений.  Это  блокировка  частоты  после  срабатывания  декодера  на  время  несколько
меньшее  длительности  сигнала  Opera-32,  задержка  принятия  решения  коррелятора  на  4
минуты с целью ожидания возможно имеющегося большего корреляционного максимума на
этой частоте. Коррелятор также ищет положение корреляционного максимума со сдвигами
относительно текущего положения. Все эти меры значительно снижают вероятность ложных
спотов. Но в ряде ситуаций возникновение ложных спотов все же возможно. Тем не менее,
Op32Rx продуцирует меньше ложных спотов, чем Opera1.6.5, в чем легко убедиться, изучая
базу данных http://spots.microwavers.es/index.php. 

Вопрос: почему количество и содержание спотов в Op32Rx и Opera1.6.5 различаются? Какие
более правильны?
Ответ: механизмы обмена спотами разные. Opera 1.6.5 имеет свой «секретный» механизм и
показывает споты только от себя. Op32Rx пользуется старым механизмом - через кластер, как
это  было  во  всех  Opera1.5.x  раньше.  Сейчас  самой  актуальной  становится  база
данных http://spots.microwavers.es/index.php ,куда помещаются споты и от Op32Rx 1.8.5(6) и
от Opera 1.6.5. Споты от Op32Rx имеют указание частоты.  Также общим ресурсом является
https://pskreporter.info/pskmap.html 

Вопрос:  какую  информацию  из  Интернета  программа  Op32Rx  использует  для
декодирования? Можно ли работать без подключения к интеренту?
Ответ:  программа  Op32Rx  не использует никакой информации, получаемой из Интернета.
Для работы нужен лишь локальный файл  callsloc.txt,  который  используется декодером для
двух целей. Во-первых, чтобы вычислить расстояние, так как файл имеет QTH локаторы и
позывные.  Во-вторых,  декодер  использует  список  известных  позывных  для  "фильтрации"
ложных декодов. Так же, как наш мозг и глаза делают с "декодированием" слабых следов
QRSS. Таким образом, если декодер декодировал некоторый позывной сигнал, он переходит
на  следующий  уровень  обработки.  Если  получился неизвестный позывной,  он  будет
отвергнут. Однако декодер не имеет информации о том, какой позывной сигнал он должен
обнаружить. Все сделано честно!  Конечно, программа будет работать без подключения к
Интернету также хорошо, как и с подключением к нему.

Вопрос: для чего в папке программы находится утилита  curl.exe?  Могу я использовать  curl
другой версии?
Ответ:  утилита  curl.exe  используется  для  отправки  спотов  в  базу  данных
http://spots.microwavers.es/.  Версия  подходит  любая,  в  том  числе  и  достаточно  старая  (и
компактная), которая использовалась в старых версиях wspr-x.

Вопрос: я хотел бы сохранять все споты, поступающие в окно Opera Chat.
Ответ: Такая возможность есть и она по умолчанию включена. Опция находится в меню окна
Opera Chat: File->Save Opera spots to log-file.  Имя файла задается в меню  Select log-file.  По
умолчанию это opera_log.txt

https://pskreporter.info/pskmap.html
http://spots.microwavers.es/
http://spots.microwavers.es/index.php
http://spots.microwavers.es/index.php


Вопрос: я не нашел в этом руководстве интересующую меня информацию.
Ответ:  посмотрите  файлы  opera_protocol.pdf,  Op32RxHelp.pdf.  Задайте  вопрос  в  рассылке
rsgb_lf_group или на форуме http://136.su/index.php/topic,277.0.html. 

http://136.su/index.php/topic,277.0.html

